


Introduction
LiMapper is an aerial photogrammetry software which can reconstruct 3D geometry structure from overlapping
images and subsequently generate a series of standard products of surveying and mapping. The key advantages
of the software include automated process, high efficiency, robust performance, and professional accuracy. All
this stems from the state-of-the-art photogrammetry and computer vision algorithms implemented in LiMapper,
which are accelerated by fully exploiting hardware resources such as multi-core CPU and high-performance
GPU. Based on data-processing experience, the algorithms are further optimized to handle not only traditional
aerial images of large frames, but also UAV-images with unstable orientations and unknown lens distortions.
Considering user friendliness the well-designed software interface is kept simple and easy to use for both novice
and expert users.

LiMapper has the scalability to process more than 10000 photos in a project. Supported source data types are
nadir, oblique, and multispectral photos. The core functions/modules of the software include feature point
extraction/matching, bundle block adjustment, camera self-calibration, dense reconstruction, DEM/DSM
generation, smart ortho-mosaicking, true orthophoto generation, stitching line editing, data visualization and
analysis.

Features

Features and Advantages

Inputs

Aerial Images

Process photos of multi-camera, multi-flight, multiple platforms
with various flight heights
Support data types of nadir, oblique, multispectral photos
Support image formats JPG, TIFF, BMP

Camera
Intrinsics

Import LiMapper Params(XML), PhotoScan Params(XML),
Australis Params(TXT)
Extract lens infos from image EXIF automatically
Group photos and edit parameters flexibly

Positions and
Orientations

Extract positions from image EXIF automatically
Import and parse external file with the formats TXT, CSV
Support local coordinate system, geographic coordinate
system, and projection coordinate system

Control
Point/Check
Point/Tie Point

Use ground control points to increase the accuracy of photos
alignment
Use check points to evaluate the absolute accuracy
Use manual tie points to register photos of featureless area

One-Stop
Process

Highly automated workflow
User-friendly interface for beginners

Align Photos

Automated images matching and bundle block adjustment
without preconditions about camera intrinsics, positions and
orientations
Integrated camera self-calibration
Editable measurement weights in bundle block adjustment
Robust performance for hard dataset such as forestry photos



Workflow

Build Dense
Cloud

Reconstruct object details through pixel-wise image matching
Generate 2.5D or 3D dense cloud

Build DEM/DSM

Extract ground points automatically to generate DEM which
meets the requirements of surveying and mapping
Generate DSM that keeps object details
Import/convert external DEM/DSM

Build
Orthomosaic

Generate true orthophoto based on DSM, and fill occlusion
area using photos taken from other view directions
Generate smart stitching lines that elude significant objects, in
order to mitigate distortions at edges
Blend images for better visual effect

Acceleration
Exploit multi-core CPU and high-performance GPU to
accelerate processing

Orthomosaic
Edit

Adjust Stitching
Line

Edit polygonal area and assign visible orthophotos
Update stitching line and orthomosaic in real time

Data
Visualization
& Analysis

2D

Quick view of input photos, corresponding feature points and
control points
Display huge orthomosaic utilizing adaptive LOD
Provide tools to measure position, length, and area of object

2.5D

Display huge DEM/DSM with hillshade effect utilizing adaptive
LOD
Provide tools to measure position, length, area, and height of
object

3D

Update tie points and camera positions in real time while
aligning photos
Disply massive dense point cloud utilizing adaptive LOD
Use EDL to enhance the rendering of depth discontinuity

Tools
Haze Removal Enhance images in pre-processing step

Image
Undistortion

Undistort images using calibration parameters

Products

Export Interior &
Exterior
Orientations

Export interior & exterior orientations after photos alignment

Export Point
Cloud

Export sparse tie points and dense point cloud as PLY, OBJ,
LAS

Export
DEM/DSM

Export DEM/DSM as TIFF, KML

Export
Orthomosaic

Export Orthomosaic as TIFF, KML

Export Stitching
Line

Export stitching line as Shape file

Get Started



Please refer to Installation and License to get the software. The usage is described in Tutorials and Workflow.



Workflow

Mandatory

New Project

One-stop Process

Exporting

Generate Report

Export Product

Optional

Extra Input

Using POS

Using GCP/MTP

Using Camera Intrinsics

Editing

Set Master Band

Remove Photos

Adjust ROI

Adjust Stitching Lines

Other

Create Project Template



New Project

New Project Wizard

Click [New] in the side menu to enter the new project page, then click on a template to activate the New Project
Wizard, and complete the project setup in the wizard's series pages.

New Project Page



Project Name： Input project name
Project Path： Input or browse project path
Project Template：Selected template. Project Template can be changed here

Load Photos Page

Rig Type

The following rig types are supported：

Nadir：For nadir photos



Oblique： For oblique aerial photos
Multispectral：For multispectral photos.

Group

Photos in each group share the same camera intrinsics. At least one group is required. Supported actions are
listed below：

Add Group：Add at least one photo as a group

Delete Group：Delete the selected group(s).

At least five photos are required to run LiMapper.

In a group's context menu, click  button to add photos to this group.

Photos

Edit photos through the following buttons:

Import POS：Please refer to Using POS.

Reset POS：Reset the imported POS.

Delete Photo：Select at least one photo and delete it.

Camera Calibration：Please refer to Camera Calibration. For multispectral photos, Master Band can be
set here, too.

Select Output Coordinate System Page

Coordinate System



The target coordinate system. The software would give a default value based on the POS information of the input
photos.

Horizontal Coordinate System: The default value is a UTM projected coordinate system. User could select a
different projected coordinate system (such as the Gauss-Krüger projected coordinate system) or a custom
projected coordinate system. In addition, the selected coordinate system must be able to be converted from
the POS coordinate system.

Vertical Coordinate System: The options are EGM2008, EGM96, EGM84 ,and custom Geoid Undulation. It is
recommended to use EGM2008, which has higher accuracy.

Geoid Undulation：The distance between the spheroid(h) and geoid surface(H): h-H.

Custom Geographic Transformation

Click [Advance...] to show the custom geographic transformation setting interface. Users can set custom 7/4/3
parameters to wrap the POS data to the target coordinate system in order to get high accuracy.

Following Procedures

Please refer to Using GCP/MTP if GCP or MTP is required.
Please refer to Process to start processing.



One Stop Process

Prerequisite

The only mandatory pre-request is creating project.

If extra input data is required, please refer to Using POS, Using GCP/MTP, Using Calibrated Camera
Intrinsics, Set Main Band for Multispectral Camera.
If some photos need to be removed, please refer to Delete Images.

Start Processing

Click  in the [Home] ribbon bar to start the one-stop processing:

The steps to be processed are already determined when the template is selected. Here you can only run
part of the steps by unchecking. Note:

There are dependencies between different steps, if dependencies were not satisfied,  button would
be disabled.
Finished step would be displayed in unchecked, re-check this step and then click the [Start Process]
button will recalculate this step.

Click  button to configure parameters in each step, please refer to Align Photos, Build Dense
Cloud, Build DEM/DSM, Build Orthomosaic.

Next steps

Refer to Generate Quality Report or Export Products if current results are satisfying.
Refer to Adjust ROI if user wants to process partial scene only to improve efficiency.
Refer to Adjusting Stitching lines if user is not satisfied with the current Orthomosaic and wants to manually
adjust stitching lines.



Generate Quality Report
Quality report can be generated after each step of Process. Quality report contains project summary, parameters,
results and running time, etc.

Click [Home]->[Generate Quality Report] on the menu bar to generate quality report in PDF format. The report will
be generated to the [1_Report] folder under project path and opened by the PDF reader.



Export Product

Export Camera Orientation

Camera orientation optimized by LiMapper could be exported to other software after completing photo alignment
by clicking [Home]->[Export]-> [Camera] on the menu bar. Refer to Camera Orientation Exporting Settings for
detail.

Export Undistorted Photos

Click [Home]->[Export]->[Undistorted Photos] on the menu bar after completing photo alignment.

Note: The undistorted photos will be saved in group and remain their origin filenames.

Export Point Cloud

3D Point cloud can be exported after completing photo alignment or dense cloud generation：

Click [Home]->[Export]->[Point Cloud] on the menu bar.
Right click on Tie Points or Dense Cloud under [Product] entry in the WorkStation Window, then click [Export
Point Cloud].

Refer to Export 3D Points Dialog for detail.

Note: Dense cloud can be exported only after completing dense cloud generation.

Export DEM/DSM

DEM/DSM can be exported after completing DEM/DSM generation.

Click [Home]->[Export]->[DEM/DSM] on the menu bar.
Right click on "DEM" or "DSM" under [Product] entry in the WorkStation Window, then click [Export
DEM/DSM].

Refer to Export DEM/DSM Dialog for detail.

Export Orthomosaic

Orthomosaic can be exported after completing Orthomosaic generation.

Click [Home]->[Export]->[Orthomosaic] on the menu bar.
Right click on "Orthomosaic" under [Product] entry in WorkStation Window, then click [Export Orthomosaic].

Refer to Export Orthomosaic Dialog for detail.

Export Stitching Line

Stitching line can be exported after completing Orthomosaic generation.

Click [Home]->[Export]->[Stitch Lines] on the menu bar.
Right click on "Orthomosaic" under [Product] entry in WorkStation Window, then click [Export Stitching
Lines].



Refer to Export Stitching Lines Dialog for detail.



Using POS
LiMapper uses POS information to speed up processing and transform the scene into real world coordinate
system.

Supported POS types

Photo EXIF txt, csv File

Position longitude,latitude,altitude longitude,latitude,altitude / XYZ

Orientation - Roll, Pitch, Heading/Omega, Phi, Kappa

Import POS

Refer to Import POS for details.

Apply POS

POS information can be used in the following three aspects:

Used in image pair selection during image matching to speed up processing.

Used in Update Alignment to transform the scene into real world coordinate system(click ).

As a Weight Factor, participate in bundle adjustment to increase robustness.
In cases of dealing with large-scale and high-resolution photos, perform Photo Alignment with the
photos alone may sometimes unable to obtain optimal results(there are outliers caused by mismatch
and errors when estimating camera distortion)
In order to improve the robustness of photo alignment, LiMapper adopts the strategy of simultaneously
adjust POS and photos. The weight of POS is of course important.

Note: If the imported camera intrinsics are inaccurate or the quality of the original photos are pool, the
reconstructed cameras may deviate significantly from the corresponding POS. In this situation, adjust POS
accuray can significantly improve the photo alignment results (for example, adjust the accuracy from the
default 10 meters to 1 meter)

Subsequent Steps

For a new project, after importing POS, please refer to one-stop process, the POS will be applied
automatically.
For project that has generated dense cloud, DEM/DSM or Orthomosaic, these previous results will be
cleared, but the photo alignment results will be preserved. If you want to use previous photo alignment
results, click [Home]->[Process]->[Update Alignment] on the menu bar to apply the imported POS, then refer
to one-stop process.



Using GCP/MTP
The quality and absolute accuracy of photos alignment can be improved by using GCP(Ground Control Point).
After photos alignment a photo of hard-to-match area, which failed to be registered automatically, could be
manually registered by using MTP(Manual Tie Point), so that a more complete result would be achieved.

Using GCP

After switching to GCP Panel, you can edit GCPs following the steps below:

1. Add or import GCPs: Please refer to the usage of Point Table;
2. Add 2D Observations: Please refer to the usage of 2D Observation Table.

Note: At least 4 uniform distributed GCPs are needed. Each GCP must be observed in at least 2 photos.

Besides, you can configure the mode how GCPs are used by clicking  in the GCP Panel.

After editing GCPs, there are 2 ways to use them:

Run Photos Alignment immediately;

Run Update Alignment in the GCP Panel by clicking , if Photos Alignment has been done before.

Using MTP

After switching to MTP Panel, you can edit MTPs following the steps below:

1. Add MTP: Please refer to the usage of Point Table. Note that the flag of the point should be changed to "Tie
Point"

2. Add 2D Observations: Please refer to the usage of 2D Observation Table. MTPs should be observed both in
unregistered and registered photos.

Note: At least 4 MTPs are needed for a unregistered photos. Each MTP must be observed in at least 2
registered photos.

After editing MTPs, you can Update Alignment photo in Photos Panel.



Using Calibrated Camera Intrinsics
User could setup camera intrinsics in LiMapper before photo alignment.

Instructions

There are two ways to setup camera intrinsics:

1. After loading photos at the [Load Photos] page of the New Project Wizard, click  for a photo group, then
setup camera intrinsics in the pop-up dialog.

2. After creating a project: click [Home]->[Tools]->[Camera Calibration] on the menu bar, then setup camera
intrinsics in the pop-up dialog.

Refer to Camera Calibration Dialog.



Set Master Band for Multispectral Data
For multispectral data, in consideration of the rigid transformation between different bands, and the difference
features of each band, it is a common strategy to select one band as master band to align first, and then align
other bands to master band using to rigid transformation constrain. Dense matching only uses master band as
well.

Instructions: Click [Home]->[Tools]->[Camera Calibration...] on the menu bar, then choose master band.
Green band is recommended for common multispectral cameras (such as Micasense RedEdge).



Remove Photos
There are two ways to remove some photos after creating project.

Remove Photos through [Workstation] or [Photo] Window

Select photos to remove in Workstation or Photo window and click [delete image] in the context menu.

Remove Photos through the polygon selection in the [3D Viewer]

One of the following conditions need to be satisfied:

After creating project, POS has been imported, and 3D Viewer is enabled to [Show POS].
After photo alignment, 3D Viewer is enabled to [Show Camera].

Procedures:

Switch to the 3D Viewer and click [3D View]->[Select Cameras]  on the menu bar to enter the editing
mode.
Draw a polygon to cover the photos need to remove, right-click to finish and select those photos.

If inverse selection is needed, click [3D View]->[Invert Selection]  on the menu bar.

Selected photos would be rendered in red. Click [3D View]->[Remove Cameras]  on the menu bar to
remove them.

Click [3D View]->[Select Cameras]  on the menu bar again to quit editing mode.



Adjust ROI
After Photo Alignment, 3D Viewer should display the tie points and a yellow Region of Interest (ROI) box. The
default ROI covers all of the scene. If you only need to reconstruct some region, you can adjust the ROI to reduce
computation for future steps. Building Dense Cloud, Building DEM / DSM and Building DOM / TDOM only work in
ROI.

Resize ROI

Click [3D View]->[ROI]->[Resize]  on the menu bar to start resizing ROI，then drag the ROI corner to resize.

Click  again to stop resizing.

Rotate ROI

Click [3D View]->[ROI]->[Rotate]  on the menu bar to start rotating ROI. Click it again to stop.

Drag to rotate the ROI



Drag the rotation circle to rotate around axis

Reset ROI

Click [3D View]->[ROI]->[Reset]  on the menu bar to reset ROI.



Adjust Stitching Lines
After building Orthomosaic, user could exam the quality. If obvious seams or poor quality areas were found,
adjusting stitching lines might produce better result.

Procedure

1.Select Target Area: Click [2D View]->[Draw Polygon]on the menu bar to activate adjustment, then left-click to
draw a polygon around the target area, right-click when finished, as shown bellow:

After drawing the polygon, if you find that you need to re-draw it, just right-click in the selected polygon area
and select [Delete Shape] in the pop-up menu.
If you need to add new vertex to the current polygon, right-click on the target place and select [insert vertex]
in the pop-up menu, the new vertex will be inserted.

2.Assign Photos: Right-click in the selected polygon area and select [Assign Photo] in the pop-up menu, then
images visible to this area will appear in the Mosaic Photos Window, as shown below:



Pick the desired image and click the [Assign] button to apply adjustment. Click [Cancel] if you want to cancel
adjustment.

3.Update Orthomosaic: Click [2D View]->[Update Orthomosaic]  on the menu bar to update the adjustment
to the final Orthomosaic. The updated Orthomosaic with the polygon deleted is shown below:





Clip Orthomosaic
After building Orthomosaic, if you want to adjust the boundary of the orthophoto to make it more regular, then you
can crop the unwanted boundary via clipping funtion.

Procedure

1.Select Target Area: Click [2D View]->[Draw Polygon]on the menu bar to activate adjustment, then left-click to
draw a polygon around the target area, right-click when finished, as shown bellow:

2.Clipping image:When a target area is selected, click [2D View]->[Clip Mosaic] on the menu bar, then the
clipped orthomosiac will be updated. Please be patient when dealing with a big image, the result is showed
bellow:



Project Template
In practice, it is common to use the same set of parameters to process different tasks in production. If user had to
configure the parameters every time, the workload would be huge, and the risk of human error would increase.
Project template is a way to solve this problem. After setting up a project template, user could use it to create new
project everytime.

Creating Project Template
Click [New] in the side menu to enter the new project page, preset templates will be listed here。

Click  to activate the template setting dialog where users can type in template title, short description (optional)
and check the steps that need to be processed, then click [OK] to generate the template.



修改工程模板

Clicking the ▼ arrow below a template can expand a drop-down menu where users can edit or delete a template.

Note:

There are dependencies between different steps, if dependencies were not satisfied, [OK] button
would not be enabled.
Click [Options ...] button to configure parameters in each step, please refer to Align Photos, Build
Dense Cloud, Build DEM/DSM, Build Orthomosaic.



Tutorials
True Orthomosaic Generation Tutorial

MultiSpectral Processing Tutorial



True Orthomosaic Generation Tutorial

Description

Processing of single/multi-camera photos of single/multiple flight(s) is supported in LiMapper, which is widely
applied to geological disaster monitoring, surveying and mapping, forestry analysis, environmental protection, etc.

Workflow

1. Preparation

(1) New Project

Input the project name and project path in New Project Wizard;
Edit project template.

(2) Load Data

Firstly, set data type as nadir. Photo group(s) should be managed as follows:

Single camera, single flight or multiple flights with overlaps: Load all photos as one group.

Multi-camera, single flight or multiple flights with overlaps: Load photos acquired by the same camera in a
group, repeat it several times to finish loading all photos.

Please refer to Loading Photos for detailed introduction.



Note: Photos in the same group shoudn't have identical names.

(3) Import POS (Optional)

If location informations in EXIF are not available, POS files of formats TXT or CSV can be imported. Please refer
to Importing POS.

Output results are in local coordinate system if project is not georeferenced.

2. Processing

(1) Mosaicking

In the Process GUI below, you can check/uncheck procedures depending on need. After clicking "Configure"
button, you can configure related template parameters.

Note: The dense point cloud type is only editable when creating template.

3. Export

(1) Export Point Cloud

Both Sparse and dense point cloud can be exported after processing. Supported formats are PLY, LAS, and
OBJ. In addition, dense point cloud can also be exported as OSGB file. Please refer to Exporting Cloud

(2) Export DEM/DSM

Users can specify coordinate system, compress method and resolution before exporting DEM/DSM. More details
can be found in Exporting DEM/DSM.



(3) Export Orthomosaic

Users can specify coordinate system, compress method and resolution before exporting Orthomosaic. More
details can be found in Exporting DEM/DSM.

(4) Export Byproducts

Please refer to Exporting Camera Parameters, Exporting Undistorted Photos, Exporting Stitching Lines, Exporting
Reports.

Example

Photos used in this case are taken in a suburb scene. There are 102 photos with the size 8256 x 6192.

Source Data

Sparse Point Cloud

Dense Point Cloud



DSM

True Orthomosaic



MultiSpectral Processing Tutorial

Description

Processing of multispectral photos of single flight is supported in LiMapper, which is widely applied to geological
disaster monitoring, surveying and mapping, forestry analysis, environmental protection, etc. Multiple bands can
be processed simultaneously and exported using custom combination.

Workflow

1. Preparation

(1) New Project

Input the project name and project path in New Project Wizard;
Edit project template.

(2) Load Data（Single flight）

Set data type as multispectral. Photos of same band should be imported as a group. Please refer to Photo
Editing.

Note：Photos in the same group shouldn't have identical names. It's not recommended to process
multispectral photos of multiple flights simultaneously.



(3) Import POS (Optional)

If location informations in EXIF are not available, POS files of formats TXT or CSV can be imported. Please refer
to Importing POS.

Output results are in local coordinate system if project is not georeferenced.

Note：There is no need to import POS separately for each band in principle, because different bands
share the same POS in general; But import per band is still supported in case of independent bands.

(4) Set Master Band (Optional)

After data import, a custom master band is also supported if needed, please refer to Master Band Setting.

2. Processing

(1) Mosaicking

In the Process GUI below, you can check/uncheck procedures depending on need. After clicking "Configure"
button, you can configure related template parameters.

Note: The dense point cloud type is only editable when creating template.

3. Export

(1) Export Point Cloud

Both Sparse and dense point cloud can be exported after processing. Supported formats are PLY, LAS, and
OBJ. In addition, dense point cloud can also be exported as OSGB file. Please refer to Exporting Cloud



(2) Export DEM/DSM

Users can specify coordinate system, compress method and resolution before exporting DEM/DSM. More details
can be found in Exporting DEM/DSM.

(3) Export Orthomosaic

Users can specify coordinate system, compress method and resolution before exporting Orthomosaic. More
details can be found in Exporting DEM/DSM.

(4) Export Byproducts

Please refer to Exporting Camera Parameters, Exporting Undistorted Photos, Exporting Stitching Lines, Exporting
Reports.

Example

The data is acquired in a town using RedEdge multispectral camera with the image size 1280*960. There are
11000 photos of 5 bands in total, 2200 photos per band.

Source Data

Example of source data

Dense Point Cloud

The dense point cloud is displayed by elevation in the software LiDAR360.



DEM

The DEM is displayed by elevation in the software LiDAR360.

Orthomosaic

The product is a pseudo-color mosaic image of bands 4,3,2.



Modules

Main User Interface

Main Window

Workstation Window

GCP/MTP Window

Photo Window

Log Window

Mosaic Photos Window

3D Viewer

Photo Viewer

DEM/DSM Viewer

Orthomosaic Viewer

Dialogs

Process Dialogs

Align Photos Settings

Build Dense Cloud Settings

Build DEM/DSM Settings

Build Orthomosaic Settings

Export Product Dialogs

Export Camera Orientation Settings

Export Points Settings

Export DEM/DSM Settings

Export Orthomosaic Settings

Export Stitching Lines Settings

Utility Dialogs

Import POS Settings

Export POS Settings

Import GCP/MTP Settings

Camera Calibration Settings

Undistort Settings



Haze Removal Settings

Other Dialog

Software Settings



Main Window
The main interface of the software contains four parts: menu bar, toolbar, viewers and docks.

Menu Bar

File

New

Create a new project.

Open

Open an existing project.

Save

Save current project.

Close

Close current project

Recent Projects

Record projects opened recently.

About
Settings

Refer to Software Settings.

Activate License



Home

Import

Including Import POS and Import GCP tools.

Camera Calibration

Refer to Camera Calibration

Process

The one-stop workflow of the software.

Update Alignment

Align to GPS or GCP, dense cloud, DEM/DSM, Orthomosaic would be removed.

Generate Quality Report

Generate a quality report in PDF format.

Export

Including [Export GCP] and Export POS. And several products like camera orientation parameters,
undistorted photos, tie points, dense cloud, DEM/DSM, Orthomosaic and stitching lines can be
exported.

Utils

Including Undistort and Haze Removal tools.

3D View

Measure
Edit Camera

Refer to Remove Photos images.

Edit ROI

Refer to Adjust ROI.

Increase Camera Size

Increasing camera frustum size in 3D viewer.

Decrease Camera Size

Decreasing camera frustum size in 3D viewer.

Show ROI

Show or hide ROI in 3D viewer.

Show GPS

Show or hide GPS location in 3D viewer.

Show Camera

Show or hide camera frustum in 3D viewer.



Show Thumbnail

Show or hide thumbnail in 3D viewer.

Show Ground Control Points

Show or hide GCP in 3D viewer.

Effect

Eye-Dome Lighting

Enable or disable EDL effect in 3D viewer.

Point and Line Setting
2D View

Manipulator

Move, measure, zoom in/out, draw polygon in 2D view
Show

Show Feature Points

Show or hide feature points in Photo viewer.

Show Shape

Show or hide Shape in DEM/DSM viewer or Orthomosaic viewer.

Show Stitching Line

Show or hide stitching lines in Orthomosaic viewer

Show Hillshade

Enable or disable hillshade effect in DEM/DSM viewer.

Update

Update DOM

Options

Window

Show or hide or Rest:

Tool Bar
Workstation Window
GCP/MTP Window
Photos Window
Log Window
Mosaic Photos Window

Viewers

3D Viewer

Photo Viewer

DEM/DSM Viewer



Orthomosaic Viewer

Docks

Workstation Window

GCP/MTP Window

Photos Window

Log Window

Mosaic Photos Window



Workstation Window
Workspace window is to manage inputs images and products of current project. Products include tie point, dense
cloud, DEM/DSM, and Orthomosaic. The tree structure of the workstation window is shown below:

Functions
Start one-stop processing: Right click [project], select [process] to open the Process wizard.

Open source image: Double click any image under [photo] entry to show it in the Photo viewer.

Delete source image: Right click image that need to be deleted under [photo] entry, then select [Delete
Photo].

Re-register image: All the registered input images has "aligned" suffix after photo alignment. If you want to
try re-register some image, right click it and choose [Re-Register Photo].

Photo Properties: Right click image under [photo] entry and select [Properties], then the [Properties]
window will pop up. As shown below:



Export Product: Products under [Product] entry (eg. Tie Point, Dense Cloud, DEM/DSM, Orthomosaic) can
be exported, just right click it and select [Export xxx]. For detail, please refer to export product.



GCP/MTP Window
The GCP/MTP Window is used to import, export, and edit GCPs(Ground Control Points) as well as MTPs(Manual
Tie Points). As shown below the GCP/MTP Window contains 3 tables from the top down: Point Table, 2D
Observation Table, and 2D Prediction Table.

Functions

Point Table



The Point Table is used for display and editing GCPs, Check Points and MTPs. The table headers are as follows:

Name：Editable point name.
Flag：Editable point flag. Supported options are GCP (used for absolute alignment), Check Point (used for
checking absolute accuracy), MTP (used for registration of photos in difficult area).
Type：Editable point type. Supported options are XYZ (horizontal and vertical), XY (horizontal), Z (vertical).
wX, wY, wZ： Editable 3D point coordinates in object space.
wError：3D point error after absolute alignment.
Relative Photos：Photos in which the point is observed.

Note: Type and 3D coordinates are deactivated if point flag is MTP.

The toolbar above the Point Table contains the following functions：

Import GCP/MTP：Import GCP/MTP from file.

Export GCP/MTP：Export GCP/MTP in the Point Table to file. Supported formats are TXT, XML.

Add GCP/MTP：Add new point into the Point Table.

Delete GCP/MTP：Delete selected point(s) in the Point Table.

GCP Settings：Set coordinate system

Update Alignment：You can run Update Alignment after Photos Alignment if there exist at least 4 valid
GCPs.

2D Observation Table

If a point in the Point Table is selected, its corresponding 2D observation(s) in photo(s) will be shown in the 2D
Observation Table. The table headers are as follows:

No.：Photo's Number.
Name：Photo's Name.
X, Y：Observation (i.e. pixel coordinates) of this point in photo.
Error：Observation's error after absolute alignment.

The toolbar above the 2D Observation Table contains the following functions：

Add 2D Observation：Firstly, you have to double-click a relative photo in the Prediction Photo(s) Table,
in order to show this photo in the Photo Viewer. Then you can click the pixel position of the point in the photo
and add this 2D observation.

An observation (i.e. pixel position) is shown as a red cross after clicking in the photo.



The red cross turns green after clicking .

Delete 2D Observation：Delete selected Observation(s) in the table.

Prediction Photo(s) Table

If a point in the Point Table is selected, its corresponding photo(s) will be shown in the Prediction Photo(s) Table.
After clicking a photo in the Prediction Photo(s) Table, the Photo Window will jump to this photo and draw 2d
prediction position immediately, so that manual search is avoided. The table headers are as follows:

Name：Photo's Name.

Predicted position is shown as green X within circle.



Note: The current version supports importing control points before Photos Alignment or not, and both
import methods support Prediction Table. But.

1. Use the Prediction Table before Photos Alignment does not support auto marker 2D observation
position, and must first import GPS data and select at least 2 2D observations of current point before
use, otherwise the prediction may have large errors.

2. When using the Prediction Table after Photos Alignment without GPS data, you need to select at least
2 2D observation of current point in registered photos manually in advance.



Photo Window
Photo window is to manage inputs images of current project, as shown below:

Functions

Photo Management

Photo selection: Both "Shift" style and "Ctrl" style multiselection and supported. As well as "Ctrl+A" for
selecting all.

Photo deletion: Right click any selected photo and choose [Delete Photo].

Photo sorting: Click the header of any column to sort the table. Click the same header to switch between
ascending and descending.

POS Management:

Import POS: Refer to Import POS for detail.

Export POS: Refer to Export POS for detail.

Reset POS: remove the existing POS.

Photo Information Management

Switch Coordinate: switch POS presentation between (X, Y, Z, Omega, Phi, Kappa) and (Longitude,
Latitude, Altitude, Roll, Pitch, Heading).

Source data: display imported POS.

 Optimized data: display optimized POS.
Photo Properties: Right click any photo and select [Properties] to view detail information about this photo.

Update Alignment

If photo alignment was completed, clicking  would align current project to imported POS.

Re-register Image

If photo alignment result was obviously wrong for some photo, user could try right-click it and choose [Re-
Register Photo].



Set POS Accuracy

Select some photos, right click and choose [Set POS Accuracy]. Then, modify the value of [Location Accuracy] or
[Rotation Accuracy] in the pop-up dialog. Refer to Use POS.



Log Window
Log window shows the log of the software. Logs are generated all over the software to tell user the status of the
software. If the software run into any trouble, logs would help to locate the problem. Logs are showed in different
colors:

Black: black log indicates the begin/end of a processing step (align photos, build dense cloud, etc).

Blue: blue log is the normal type. Parameters and progress are showed in blue. If a blue log started with a
Warning, user should take caution as there might be something wrong. In most case, the software could
keep running after warning.

Red: red log indicates critical error, such as file I/O error.



Mosaic Window
Mosaic panel is to assist stitching lines editing( refer to Adjust Stitching Lines for details of editting stitching lines).
It consist of Visible Orthophotos list, Assign button and Cancel button, as shown below:





Functions

Browse the Effect of Stitching Lines Adjusting

Visible Orthophotos lists all the visible photos in the edited area of the Orthomosaic viewer, orthophotos are
sorted by valid area in descending order. Click a photo to view the overlay effect in Orthomosaic viewer.

Assign Photos

After determining the best overlay orthophoto, click [Assign] to adopt the overlay and clear Visible Orthophotos
list..

Cancel

Click [Cancel] to abandon current editing and clear Visible Orthophotos list.



3D Viewer
3D viewer is to show cameras, tie points, and dense cloud. After finishing photos alignment and dense cloud
generation, user could double-click the tie points or dense cloud at Workstation Window to show it in the 3D
viewer.

Functions

Pan: Press mid-key then drag.

Zoom: Scroll up/down the mouse wheel.

Rotate: Press left-key then drag.



Photo Viewer
Photo viewer is to show the input photos. After creating project or opening project, user could double-click the
input photo at Workstation Window or Photo Window to show it in the Photo viewer.

Functions

Pan: Press left-key or mid-key then drag.

Zoom: Move the mouse to the expected zoom center then scroll up/down the mouse wheel.



Viewer DEM/DSM
DEM/DSM viewer is to show DEM/DSM. After Building DEM/DSM, user could double-click the DEM or DSM at
Workstation Window to show it in the DEM/DSM viewer.

Function

Pan: Press left-key or mid-key then drag.

Zoom: Move the mouse to the expected zoom center then scroll up/dowm the mouse wheel.



Orthomosaic Viewer
Orthomosaic viewer is to show Orthomosaic. After Building Orthomosaic, user could double-click the
Orthomosaic at Workstation Window to show it in the Orthomosaic viewer. User could also adjust stitching lines
in the Orthomosaic viewer.

Function

Pan: Press left-key or mid-key then drag.

Zoom: Move the mouse to the expected zoom center then scroll up/down the mouse wheel.



Align Photos

Brief

Photo alignment is to reconstruct camera orientation and sparse 3D scene structure based on input image,
geographical location information(GNSS, GCP, optional) and Initial Camera Intrinsics(optional). Currently, result
of photo alignment can be used for building dense cloud, building DEM/DSM, and building Orthomosaic.

Settings

Photo alignment procedure includes feature point detection, feature point matching, and bundle adjustment. The
parameters are described below:

Feature Point Detection

Max Dimension: Input images are sampled during feature point detection (upsampling or downsampling)
according to this parameter.

High(Default): Detects the largest number of feature points, more robust than Medium and Low,
meanwhile, consumes the longest time.
Medium: Detects less feature points than High, consumes less time than High.
Low: Detects the smallest number of feature points, consumes the least time.

Note: Within a certain range, detecting more feature points could improve robustness. However, if feature
points were too many, result might get bad as too much noise might been introduced. The software has
made the trade-off between efficiency and robustness, in most cases using the default High option could
get the best result.

Max Features(Default"8192"): The max number of feature points in each image. Increasing this threshold
could lead to a longer processing time.

Note: The software has made the trade-off between efficiency and robustness, in most cases using the
default 8192 threshold could get the best result.

Feature Point Matching

Pair Selection Mode: In order to improve the efficiency of feature point matching, image pair selection is
performed. Feature point matching is only performed between the selected image pairs. Currently, there are
three image pair selection modes: Generic, Exhaustive, Reference.

Generic(Default): Down-sampling original image and matching low-resolution images to select image
pairs.
Exhaustive: Selecting all image pairs, which is time consuming.
Reference: Selecting image pairs according to the geographic location information of the image (read
from EXIF or imported from POS file).

Note: The Reference mode is valid only in the presence of geographic information. In most cases, using
the default option Generic could get the best result. If the photo alignment result is obviously wrong, try
Exhaustive mode might get better result.

Max Tie Points(Default"1024"): The maximum number of two-view tie points between two images. Too few
two-view tie points will affect the accuracy of processing results and might even lead to processing failure. In



most cases, using the default 1024 could get the best result.

Bundle Adjustment

Refine Intrinsics(Default"Refine All Intrinsics"): Check to refine specific intrinsics, supported intrinsics
include focal length (f), principal point (cx, cy), radial distortion parameters (k1, k2, k3), tangential (eccentric)
distortion parameters (p1, p2), the imaging plane distortion parameters (b1, b2). The self-calibration
algorithm within the software can obtain good estimation of intrinsics even if there are no initial intrinsics
provided. Using Calibrated Intrinsics is also supported. If the imported intrinsics are very accurate, there's no
need to check Refine Intrinsics, thus the camera intrinsics remain unchanged during bundle adjustment.

Refine Extrinsics(Default"Refine All Extrinsics"): Check to refine specific Extrinsics, supported extrinsics
include rotation(R) and translation(T) parameters. Don't change default value unless you have known
accurate parameters.

Estimate Offset(Default"Estimate None"): Check to estimate GPS/IMU offset and the GPS offset can only
be accurately estimated in the case of high GPS accuracy and accurate ground control points (GCP).

Outliers Threshold(Default"6.00"): The upper bound of the inlier reprojection error (in pixels) during bundle
adjustment. Tie point with reprojection error larger than this value would be treat as outliers and removed.
This strategy could suppress the influence of the outliers.



Build Dense Cloud

Brief

Based on cameras' intrinsics, positions and orientations, which are optimized in photos alignment, the program
generates a dense point cloud from the input images utilizing state-of-the-art MVS(Multi-View Stereo) algorithms.
This dense point cloud can be exploited to analyze the geometry of the reconstructed objects or be used as input
to build DEM/DSM.

Settings

The parameters are described below:

Quality: This parameter defines the pyramid level of input images. Higher quality corresponds to larger
image scale, which takes longer processing time.

Ultra High: Original image scale is used to build dense cloud. More details are reconstructed with this
option than with High quality, especially in easy-to-match areas(e.g. city). This option takes the longest
time.
High(Default): 1/2 image scale is used to build dense cloud. This is the default option.
Medium: 1/4 image scale is used to build dense cloud. Less details are reconstructed with this option
than with High quality. However, more points are generated in difficult areas(e.g. vegetation). This
option takes less time than default.
Low: 1/8 image scale is used to build dense cloud. Less details are reconstructed with this option than
with High or Medium quality. However, more points are generated in difficult areas(e.g. vegetation).
This option takes the shortest time.

Type: This parameter defines the type of output dense cloud. It can be edited only in template creation.
2.5D(Default): Rasterized 2.5D result excluding vertical faces is outputted.
3D: 3D result including vertical faces is outputted. This option is suitable for complete dense cloud
reconstruction.



Build DEM/DSM

Brief

The program builds DEM (Digital Elevation Model) or DSM (Digital Surface Model) from object 3D points. If dense
cloud were built, dense points would be used as input source data; If not, sparse tie points from photos alignment
would be used. DEM/DSM can be outputted as production or be used as input data to build Orthomosaic.

Settings

The optional modes and their parameters are described below:

Build DEM

In this mode, ground points are extracted with the algorithm CSF(Cloth Simulation Filter). DEM is then built from
ground points using IDW (Inverse Distance Weighted) interpolation. The related parameters are as follows.

Terrain Type（Default"normal"）：This parameter defines the terrain type(three options: flat, normal,
steep). Generally, the urban area is flat or normal, and the mountainous area is steep. Please set this
parameter according to the actual topographic relief in the region.
Filter Size（Default"2.0"）：This parameter defines the grid size of cloth which is used to cover the terrain.
Keep the default value in the most case unless the terrain is steep(set 0.5~1 for mountain area).
Resolution：This parameter defines the spatial resolution (Unit: [m]) of the output DEM. Smaller value
corresponds to higher resolution, which takes longer processing time.

Auto（Default）：If checked, the highest resolution with a scale factor is used. This option is checked
with scale factor 2 by default.
Manual：If checked, you can input a value.

[1] W. Zhang, J. Qi*, P. Wan, H. Wang, D. Xie, X. Wang, and G. Yan, “An Easy-to-Use Airborne LiDAR
Data Filtering Method Based on Cloth Simulation,” Remote Sens., vol. 8, no. 6, p. 501, 2016.

Build DSM

In this mode, DSM is built from all input points using IDW interpolation. The related parameters are as follows.

Resolution：This parameter defines the spatial resolution (Unit: [m]) of the output DSM. Smaller value
corresponds to higher resolution, which takes longer processing time.

Auto（Default）：If checked, the highest resolution with a scale factor is used. This option is checked
with scale factor 2 by default.
Manual：If checked, you can input a value.



Build Orthomosaic

Brief

Based on cameras' orientations and DEM(Digital Elevation Model), DSM(Digital Surface Mmodel), the program
builds a Digital Orhomosaic or True Digital Orhomosaic from the input images. Image undistortion, image
orthorectification, exposure compensation, color correction, image stitching, and image blending are included in
this program.

Settings

The optional modes and parameters are described below:

Modes

The generation mode includes five types, which are divided according to data source and mosaicing mode. The
data source includes DSM, DEM(generated by "Build DEM/DSM" or self-defined). Generally speaking, the high
accuracy of DSM makes it easier to get the correct pixel position in the process of ortho-rectification, so as to
obtain a better quality orthomosaic. For example, in urban areas, some buildings always inclined in the
orthomosaic generated by DEM beacuase of the big elevation difference of buildings. On the other hand, for
some flat areas with little elevation difference, the orthomosaics generated by DEM or DSM may not have distinct
difference. In addition, the software provides two mosaicing methods: pixel-level mosaic and object-level mosaic.
Pixel-level mosaic is generating orthomosaic with weighted ortho region of the image, which requires DSM/DEM
in high accuracy and in accordance with the actual terrain, otherwise it is prone to distortion and stretching.
Object-level mosaic reduces geometric distortion by generating intelligent stitching lines around ground objects.
This method is a traditional method to generate orthomosaic using DEM, and can be used as a good alternative.

Pixel-level mosaic based on DSM (Digital Surface Model): Generating orthomosaic by Pixel-level method
based on DSM. In most cases, this mode has the fastest processing speed and the best result.
Pixel-level mosaic based on DEM(Digital Elevation Model): Generating orthomosaic by Pixel-level
method based on DEM. this mode may have a good result in some area forests with big canopy. And the
position accuracy of ground objects in orthmosaic may decrease because the using of DEM.
Object-level mosaic based on elevation model: This model uses DEM to generate orthophoto images,
and generates intelligent bypass stitching lines to reduce deformation. It has good result in vegetation
environment such as farmland, grassland and shrub. When the result of "pixel-level mosaic based on DSM"
is not very good, this mode can be used as an alternative. Note that this mode will take more time.
Pixel-level mosaic based on self-defined Model: Generating orthomosaic by Pixel-level method based on
self-defined surface，DSM is recommended.
Object-level mosaic based on self-defined Model: Generating orthomosaic by object-level method based
on self-defined surface，DEM is recommended.

Note: The coordinate system of self-defined terrain data will be converted to the current project coordinate
system when imported. If there is no coordinate system information contained in the terrain data, the user
must set the correct coordinate system first. When choosing a mode, the user must build or import
cooresponding DEM and DSM, if not, the calculation will be terminated.

Parameters



Blend Level（Default"High"）: including 5 options such as: "High", "Medium", "Low", "Very Low", and
"No". "No" means skipping image blending. If the average size of orthophotos was larger than 3000 x 3000,
blend level would be the higher the better. If the average size of orthophotos was smaller than 1000 x 1000,
a "Low" or "Very Low" blend level would be recommended as higher blend level might result in a low contrast
Orthomosaic.
Color Correction（Default"Enabled"）: If enabled, the program wound adjust input images' brightness,
contrast, saturation and white balance during orthorectification. In most case, enabling this function could
result in a visually better Orthomosaic. If input images were multispectral images, this function would be
banned.
Max Oblique Angle（Default"60 degree"）: Images with oblique angles larger than this value is filtered as
they tend to cost too mush computation resource but generate pool results.
Resolution: This parameter defines the spatial resolution (Unit: [m]) of the output Orthomosaic. Smaller
value corresponds to higher resolution, which takes longer processing time.

Auto（Default）：If checked, the highest resolution with a scale factor is used. This option is checked
with scale factor 1 by default.
Manual：If checked, you can input a value.



Export Camera Orientation

Brief

Exporting camera Orientation into Bundler (*.out), Omega Phi Kappa (*.txt), BlocksExchange XML format (*.xml),
Inpho Project File (* .prj) and other third-party formats so that third-party software could use the result of
LiMapper.

Settings

The parameters are described below:

Coordinate System: This parameter defines the target coordinate system of the output data
Export Undistorted Photos: Check this option to export undistorted Photos

Note：Different softwares using different definitions of camera model, in order to maintain the commonality
of data, the distortion parameters are set to 0, so it is recommended to export the corresponding
undistorted photos.



Export Point Cloud

Brief

Export point cloud generated by LiMapper into common point cloud formats, such as PLY, OBJ, LAS and so on.

Settings

The parameters are described below:

Coordinate System: This parameter defines the target coordinate system of the output data，including
horizontal coordinate system and vertical coordinate system. Please refer Coordinate System
Custom Geographic Transformation(optional)：Custom parameters used to convert the output data to
the selected horizontal coordinate system
Source： Choose data source

Sparse Point Cloud: Choose Tie Points generated by photo alignment as data source
Dense Point Cloud: Choose Dense Cloud generated by dense matching as data source

Point colors: Export point color if checked
Point normals: Export point normal if checked

Note: LAS format does not support "Point nornamls" option

Point classification: Export point classification if checked

Note: if DEM is not generated, all point clouds are not classified. DEM generation divides point clouds into
two class: ground and non-ground.



Export DEM/DSM

Brief

Export the DEM/DSM generated by LiMapper into common raster data format, such as TIF, KML and so on.

Setting

The parameters are described below:

Coordinate System: This parameter defines the target coordinate system of the output data，including
horizontal coordinate system and vertical coordinate system. Please refer Coordinate System
Custom Geographic Transformation(optional)：Custom parameters used to convert the output data to
the selected horizontal coordinate system
Compression: Select the compression method

NONE: No compression
LZW: Use LZW compression which is lossless

Resolution X (m)：X-direction resolution
Resolution Y (m)：Y-direction resolution
Saving KML：Check to export the KML format file simultaneously

Note：The KML format file only supports the WGS84 coordinate system, so this option is only
available if you choose WGS84 coordinate system



Export Orthomosaic

Brief

Exporting Orthomosaic generated by LiMapper into common raster data format such as TIF or KML.

Settings

The parameters are described below:

Coordinate System: This parameter defines the target coordinate system of the output data，including
horizontal coordinate system and vertical coordinate system. Please refer Coordinate System
Custom Geographic Transformation(optional)：Custom parameters used to convert the output data to
the selected horizontal coordinate system
Compression: Select the compression method

NONE: No compression
LZW: Use LZW compression which is lossless
JPEG: Use JPEG compression which has a high compression ratio but is loosy

Resolution X (m)：X-direction resolution
Resolution Y (m)：Y-direction resolution
Saving KML：Check to export the KML format file simultaneously

Note：The KML format file only supports the WGS84 coordinate system, so this option is only
available if you choose WGS84 coordinate system



Export Stitching lines

Brief

Exporting the stitch lines generated by LiMapper into common vector data format such as Shape File (* .shp).

Settings

The parameters are described below:

Coordinate System: This parameter defines the target coordinate system of the output data，including
horizontal coordinate system and vertical coordinate system. Please refer Coordinate System
Custom Geographic Transformation(optional)：Custom parameters used to convert the output data to
the selected horizontal coordinate system
Export orthophotos: Check this option to export orthophotos

Compression: Select compression method for orthophotos
NONE: No compression
LZW: Use LZW compression which is lossless
JPEG: Use JPEG compression which has a high compression ratio but is loosy

Resolution X (m): X-direction resolution for orthophotos
Resolution Y (m): Y-direction resolution for orthophotos

NOTE: Stitch lines are associated with orthophotos. Both of them are needed for stitching lines editing. So
it is recommended to export orthophotos.



Import POS
There are two types of POS supported to import to LiMapper.

Import POS from EXIF Embedded in the Photo File

Most GNSS receiver integrated UAV can write longitude, latitude and altitude in WGS84 coordinate system to
photo file as EXIF when capturing photos. LiMapper can read these POS information automatically when loading
photos. By the way ,the UTM projection coordinate system is determined by longitude, latitude and altitude of the
first photo.

Import POS in TXT and CSV Format File

There are three ways to import POS file in LiMapper, as described below:

1. Click  button in the [Load Photo] dialog of New Project Workflow

2. Click  button in the Photo Window

3. Click  in the [Home] ribbon bar

Select POS file in the pop-up [Open POS] dialog and click open button. Set related parameters and click OK
button in the [POS Editor] dialog to import POS.

If the imported POS is incorrect, user could click  button in Photo Window to clear current POS.

The parameters in the [POS Editor] are described below:

Separator (optional)

Adjust the separator to allow the data to be displayed normally. "TAB", "\t", "\n" "," and any combination of them
are supported by LiMapper. The combination separator is default. User could also input other delimiter.

Rotation Angles (optional)

Select the type of imported rotation angles. User could discard rotation angles by setting the rotation angle
column headers to ignore.

Skip Lines (optional)

Ignore some lines at the beginning of the POS file. Skipping no line is default.

Coordinate System (required)

Coordinate system of imported POS，click the [Edit...] button to change it, options for horizontal coordinate
system are arbitrary, geographic systems, and projection systems, options for vertical coordinate system are
EGM2008, EGM96, EGM84 and custom geoid undulation.

Column Header (required)

Select valid column header for each column.

FAQ：

1. Q: Is it allowed to assign the same header to two columns or more ？
A: It is prohibited.



2. Q: Is it needed to import POS group-wise？
A：No need. Bud if the POS is organized separately, group-wise import are supported.

3. Q: What does the hint of "Photo name does not match!" mean? And why are some items highlighted in
red? A：The hint of "Photo name does not match!" means that part of photos could not find
corresponding POS in the imported POS file. The highlighted items contains invalid value.

4. Q: What does the warning of “GPS data out of range！” mean？
A：The selected coordinate system does not match the coordinate system of the imported POS.



Export POS

Brief

Exporting initial or LiMapper optimized image POS into a text file.

Settings



The parameters are described below:

Coordinate System: This parameter defines the target coordinate system of the output data，including
horizontal coordinate system and vertical coordinate system. Please refer Coordinate System
Custom Geographic Transformation(optional)：Custom parameters used to convert the output data to
the selected horizontal coordinate system
Data source: Select data source

Source data: Initial POS
Optimized data: LiMapper optimized POS

Separator: Set the data column delimiter
Column settings: Select columns to export

Export Position(Mandatory): Export the position of the image
Export Orientation: Export the orientation of the image
Accuracy: Set the precision of the exported data



Import GCP/MTP

You can click  in the [Home] ribbon bar, or click  in the GCP/MTP Window to browse file for GCPs import.
Supported formats are as follows:

TXT：This file must contain point names and 3D coordinates informations. Data columns have to be
separated using specific symbol(s).
XML：Proprietary format of LiMapper. It contains point names, 3D coordinates, 2D observations, etc.

While importing TXT file, the GCP Editor will be shown:

Configuration options in this interface are as follows:

Coordinate System
The coordinate system of imported data, click the [Edit...] button to change it, options for horizontal
coordinate system are arbitrary, geographic systems, and projection systems, options for vertical coordinate
system are EGM2008, EGM96, EGM84 and custom geoid undulation.

Skip Lines
The leading lines (e.g. comments) can be skipped. No lines are skipped by default.

Headers
A column header (e.g. Latitude, Longitude, Height) can be specified by clicking the header and selecting
attribute in the pop-up list.

Separator
The Separator is used for data column separation. Supported separators are SPACE, TAB, COMMA,
SEMICOLON, and their combination. The combination is used by default. Besides, custom symbol can be
inputted in the textbox.



Camera Calibration
Camera distortion is inevitable and harmful to accuracy. In practice, cameras are often pre-calibrated in order to
achieve high accuracy. This software could use pre-calibrated camera intrinsic as initial value to run photo
alignment.

In this dialog, user could edit the camera intrinsic manually. Refer to Camera Model for definition.
In this dialog, user could import and export camera instrinsic. Australis camera model(.txt), LiMapper camera
model(.txt) are supported. PhotoScan camera model(.xml) without k4, p3, p4 is also supported.
In this dialog, user could set master band for multispectral photos.
In this dialog, user cloud also view the optimized camera intrinsic.



Undistort

Brief

Undistort dialog allows users to correct the distortion of images caused by CCD or lens defects. To fulfill the job,
users should specify the parameters of the camera.

Parameter Description

These parameters include focal length, pixel size, principal point offset, CCD correction, radial distortion and
decentering distortion. Please refer to camera model for interpretation.

In addition, User can check [Image Enhancement] to improve image sharpness and contrast.



Haze Removal

Brief

The purpose of Haze Removal is to improve image quality. Haze Removal dialog is shown below:

Settings

Available parameters are described below:

Block: An image is divided into blocks, the larger the block size is, the smaller the number of the divided
image blocks is.
Radius: The size of the filtering radius of the guided filtering, which affects the quality of the filtered image.

The smaller the filtering radius is, the clearer the image detail is.
The larger the filtering radius is, the more blurred the detail of the image is.

Input: Select the input image folder.
Output: Select the output image folder.



Software Settings

Brief

Set the global parameters and show the current coordinate system.

Settings

Available parameters are described below:

CUDA Device: Set the CUDA device to be used
Language: Select the display language

Chinese(Simplified)
English(US)



FAQ
Installation And Licensing

Tips And Tricks

Trouble Shooting



Installation And Licensing
What are the hardware requirements to install LiMapper?

CPU：Intel Core i5 or equivalent(minimum), Intel Core i7(recommended)
GPU：NVIDIA GTX750 Ti or equivalent(minimum), NVIDIA GTX1060 or better(recommended). CUDA,
SM20 or better, 2GB Memory at least
DISK：1GB free disk space for installation; Required space for processing depends on data size, 500GB
free disk space(recommended)
RAM：16GB(minimum), 32GB or more(recommended)

What are the supported Operating Systems?

Windows 7：Windows 7 SP1, Windows Update KB2999226 required.
Windows 8：Windows 8.1, Windows Updates KB2919355, KB2919442 required.
Windows Server 2012 RC2：Windows Updates KB2919355, KB2919442 required.
Windows 10：No additional requirements.

What if the hardware & system requirements are satisfied but the software still doesn't work properly ?

Install Visual C++ Redistributable for Visual Studio 2015 x64.If failed, please update your operating system
and try again.
If your problem is still unsolved, please send an email with problem description to info@greenvalleyintl.com.
and we will reach out to troubleshoot as soon as possible.

How to resolve the error "No CUDA device is found" when launching LiMapper?

Please update the drivers of your CUDA devices. If no CUDA devices are available on your machine, please
ignore the error.

Note: CUDA device increases the software efficiency.

How to check if CUDA devices are available on the machine?

Launch LiMapper, Click [File]->[Settings] , the recognized CUDA device(s) are listed.

What if LiMapper doesn't recognize your NVIDIA graphics card?

Please download and update the driver to the latest version from the NVIDIA official website.

https://www.microsoft.com/en-us/download/details.aspx?id=49077
https://www.microsoft.com/zh-cn/download/details.aspx?id=42335
https://www.microsoft.com/en-us/download/details.aspx?id=42135
https://www.microsoft.com/en-us/download/details.aspx?id=42334
https://www.microsoft.com/en-us/download/details.aspx?id=42153
https://www.microsoft.com/en-us/download/details.aspx?id=48145
mailto:info@greenvalleyintl.com


Tips And Tricks
How to change the menu language?

Click [File]>[Settings]>[Language] , and change language. Language change needs a restart to be effective.

How to break processing?

Click [Stop Process] in [Process] ribbon to break processing.Please note that you need to wait a while for
all the multi-thread tasks and GPU calculation tasks to be terminated. A process can be resumed from the
break point. Please refer to [How to resume from break point?]

Can I resume the process from the break point?

Yes, in the cases that the system crashes, the computer is shut down by accident, or user breaks the
processing, the process can be resumed from the break point, which saves a lot of processing time
comparing to restarting from scratch. Resuming from the break point is supported in the following processes:
[Align Photo]
[Build Dense Cloud]
[Build Orthomosaic]

How to resume the process from the break point?

Click [Start Process] in [Process] ribbon to resume from the break point..

What if the deviations between initial camera positions and the positions after photo alignment are large
(object in the scene is distorted)?

Please evaluate the accuracy of the initial camera position information (coordinates embedded in photo EXIF
or imported POS file), and Adjusting POS Weights in LiMapper to match before running the process. The
higher the accuracy of initial position, the smaller the discrepancy between initial position and adjusted
position after photo alignment.

Can I generate orthomosaic imagery using external DEM/DSM such as DEM/DSM generated from LiDAR
point cloud, and how?

Yes. Before processing [Mosaic], click [Configure] in [Process] ribbon. Under [Build Orthomosaic] tab, select
[Pixel-level mosaic based on self-defined surface] or [Object-level mosaic based on self-defined surface]
mode, and enter the external DEM/DSM.



Trouble Shooting
Why does Create/Save Project fail?

Please make sure you have read and write access to the project folder. Do not save your project in the
system protected paths such as "C:/Program Files", "C:/Users", "C:/Windows", etc.
Please make sure there is enough space in the project drive. The generated products such as dense cloud
and orthomosaic imagery are usually large datasets which require large storage space..
If the problem remains, please send an email with problem description to info@greenvalleyintl.com. We can
provide remote assistance.

Why does different data crash frequently on one computer and work correctly on others?

Check and make sure the current Windows user has read and write access to the project folder.
If the current project folder is on a cloud drive, change project folder location to a local drive and try again.

In what cases would a project processing fail?

The scene to reconstruct does not have enough texture features, such as large area of waterbodies and
snow-covered landscape.
There is not enough overlapping between photos. The minimum required flight front overlap is 60% and the
minimum flight side overlap is 30%. Note: when the flight altitude is consistent throughout the flight but the
elevation change of the landscape is large, the photos captured at the regions with high elevation might not
have enough overlapping. Therefore, in this case, please increase the front and side overlapping ratio, or
use terrain-followed mode for the flight.

What should I do if a BSOD happens during building dense cloud or building Orthomosaic?

If your CPU is Intel I7-7820X, this is likely to be a driver bug. The solution is to switch the [CPU Core Usage]
to "Auto" instead of "Sync All Cores" or "By Core Usage" in BIOS.
If the problem remains, please send an email with problem description to info@greenvalleyintl.com

What should I do if the software crashed when building orthomosaic after loading the image infomation?

If your graphic card is NVIDIA GTX 16 series(eg. GTX 1660) and LiMapper version is before 3.1Update5, try
to uncheck the CUDA option checkbox in the settings, in this case, only CPU is running for program.

mailto:info@greenvalleyintl.com
mailto:info@greenvalleyintl.com
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Glossary
POS: Position and Orientation System

GCP: Ground Control Point

MTP: Manual Tie Point

DEM: Digital Elevation Model

DSM: Digital Surface Model

Orthomosaic: Digital Ortho Map

True Orthomosaic: True Digital Ortho Map



Camera Model

Principle

The camera model defines the transformation between image space coordinate system and pixel coordinate
system.

Image space coordinate system: The origin is projection center. The Z axis points towards the viewing
direction, X axis points to the right, Y axis points down.
Pixel coordinate system: The origin is the top left corner of the top left pixel. In other words, the coordinates
of the top left pixel's center is (0.5, 0.5). The X axis points to the right, Y axis points down.

The notations are described below:

(X, Y, Z)        - point coordinates in the image space coordinate system

(u, v)          - projected pixel coordinates

(c , c )         - principal point offset

(K , K , K )      - radial distortion coefficients

(P , P )        - tangential distortion coefficients

(B , B )        - affinity and non-orthogonality (skew) coefficients

(w, h)         - image width and height in pixels

f            - focal length

Equations of the transformation are described below ：

x = X / Z

y = Y / Z

r = sqrt(x  + y )

x' = x(1 + K r  + K r  + K r ) + P (r +2x ) + 2P xy

y' = y(1 + K r  + K r  + K r  ) + P (r +2y ) + 2P xy

u = w * 0.5 + cx + x'f + x'B1 + y'B2

v = h * 0.5 + cy + y'f

LiMapper Internal Parameters File(*.xml)

<?xml version="1.0" encoding="UTF-8"?>  
<calibration>  
    <width>8256</width>  
    <height>6450</height>  
    <f>6771.25</f>  
    <ps>0.00436047</ps>  <!-- pixel size -->
    <cx>4.57016999999996</cx> 
    <cy>3.04289000000017</cy>  
    <k1>-0.0778992</k1>  
    <k2>0.0695091</k2>  

x y
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1 2

1 2

2 2 
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2
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    <k3>-0.0223276</k3>  
    <p1>-2.68206e-5</p1> 
    <p2>0.000617037</p2>  
    <b1>6.06111\</b1>      
    <b2>-0.816488\</b2>  
</calibration>



ChangeLog

LiMapper3.2

1. Solved the problem that CGCS2000 coordinate system under exported TIF image is not displayed correctly.
2. Fixed bug of generating DEM / DSM failed when using sparse point cloud sometimes.
3. Fixed bug when delete image group after extacting features.
4. Fixed error coding in the log when showing chinese character.
5. Fixed bug of coordinate transform in seven parameter transfromation when the target coordinate is

georeference coordinate system.
6. Fixed bug of updating parameter incorrect in camera calibration panel。

LiMapper3.1 Update6

1. Modified the range of GSD.
2. Fix error of progress bar and user interface flash when image alignment failed.
3. Reconstruted image alignment module which is completely independent.

LiMapper3.1 Update5

1. Fixed crash when building orthomosaic with NVDIA 16 series graphic card.
2. Solved the problem that the project can't be opened after the project and data are moved. A wizard was

provided to help the user to find the image directory in case of failure to automatically obtain the image of the
project directory.

3. Improved the DSM algorithm.
4. Fixed bug in image alignment
5. Fixed the problem of warning box popping up when loading template each time.

LiMapper3.1 Update4

1. Fixed error of calibration parameter P1，P2 for building dense cloud points.
2. Added funtion for clipping orthomosaic
3. Fixed problem on the control point panel caused by signal reception error.
4. Fixed memory leak in the panel of attribution.

LiMapper3.1 Update3

1. Improved DEM filter algorithm
2. Support to build orthomosaic with cpu and cuda concurrence。
3. Fixed bug of importing POS and improve the accuracy of automatic setting table header (longitude, latitude,

elevation) according to general practice.
4. Fixed bug of display dense cloud points and sparse points.
5. Solved image rotation when loading image.

LiMapper3.1 Update2

1. Improved rotation matrix calculation for camera.



LiMapper3.1 Update1

1. Imporved placement calculation, taking into account the effect of meridian deviation of projection.
2. Fixed the problem of incorrect estimation of parameters in different bands of the multispectral image.
3. Fixed the problem of rotation angle error calculation in the image information panel.
4. Fixed the bug of automatic work flow.
5. Solve the warning message of building orthomosaic when no valid DEM/DSM is found.
6. Fixed the terrain exporting function in the workspace.
7. Support omega, phi, kappa and roll, pitch, heading parameter when exporting POS.
8. Fixed bug of the double SpinBox garbage value in the GPS/IMU offset summary.
9. Fixed the bug of exporting quality report that there is no DEM/DSM thumbnail generated when user chooses

external import.

LiMapper3.1

Highlights and Key Features

1. Add support to 2d,3d and elevation points in the GCP import panel and allow users to set control point types
and add support for CSV format.

2. Adjust the layout and display of the GCP panel to make user operation and viewing more flexibility.
3. Adjust the logic of DEM/DSM generation to generate/export both DEM and DSM results.
4. Provide five modes in "Build Orthomosaic" configuration.
5. Support for DJI PHANTOM 4PRO wide-angle lens.

Fixed Bugs

1. Fix the bug that geographic transform may failed in three-parameter mode.

LiMapper3.0

Highlights and Key Features

1. Support to export tiled DEM/DSM/Orthomosaic

Fixed Bugs

1. Fix the bug that software stayed in file menu when opening a project by double-clicking its .limap file

LiMapper2.4 Update2

Highlights and Key Features

1. Add more bundle adjustment parameters in Quality Report
2. Add a new dock [Property] to show project/photos/products property
3. Improve log details

Fixed Bugs

1. Fix the bug that DEM/DSM maybe not be shown under right color

LiMapper2.4 Update1

Highlights and Key Features



1. Support 2% stretched display for DSM
2. Support to import and export GCP in GPX or SHP format
3. Remove thumbnail inside workstation
4. Support to import and export 7/4/3 parameters
5. Improve dense cloud

Fixed Bugs

1. Fix typo in UI
2. Fix a bug related to export DEM/DSM
3. Ban importing POS or GCP when project has no target coordinate system
4. Fix the bug that software may crash after removing photos
5. Fix the bug that the return button for the file menu may not be displayed properly

LiMapper2.4

Highlights and Key Features

1. Add an accuracy factor for GCP
2. Improve visual effect for dense cloud
3. Add a human-readable log file
4. Improve overlap report for hill area

Fixed Bugs

1. Fix a bug that measurement unit other than meter could not be rendered properly

LiMapper2.3

Highlights and Key Features

1. Change UI style to Ribbon
2. Support choosing target coordinate system when creating new project
3. Support vertical coordinate system
4. Support coordinate system wrapping using 7/4/3 parameters
5. Support importing camera parameters from Inpho
6. Support GPS/IMU offset calculation

Fixed Bugs

1. Fix a bug that the software might crash if project name has invalid character

LiMapper2.2

Highlights and Key Features

1. Improve color balancing quality when generating low-resolution orthomosaic
2. Add a scale factor when choosing auto resolution for DEM/DSM, orthomosaic generation
3. Support resuming from breaking-point for dense cloud generation
4. Update project templates
5. Support mannal editing of Australis camera model and support scientific notation in Camera Calibration

dialog
6. Optimize user interface such as adding feature points notation



Fixed Bugs

1. Fix the problem that the software might crash during orthomosaic generation
2. Fix the problem that the default project location is invalid
3. Fix a bug during absolute alignment for multispectral photos

LiMapper2.1

Highlights and Key Features

1. Add project templates, including templates for checking flight quality, 3D point cloud production, and
mosaicking orthophoto

2. Improve the algorithm for unifying ray and color and reducing the color difference of after image stitching,
which has better adaptability for underexposed images;

3. Support to generate more accurate image mosaicking results by using LiDAR-based high-precision digital
elevation models

4. Improve the aerotriangulation algorithm and the algorithm of mosaicking orthophotos, and support big data
(300 million pixels per image) processing

5. Improve the dense image matching algorithm to increase the module stability;
6. Add new project wizard to simplify the operation process
7. Support multi-spectral data, including processing images with multiple bands simultaneously and exporting

mosaicked multi-spectral data
8. Add more data statistics in the quality report, such as flight strip overlap rate, study site area, average flight

height, and operation time
9. Support opening a project by dragging and dropping the project file into the software window

10. Compatible with project files of lower versions (v2.0 and v1.4)
11. Improve the visualization and saving of ground control points, which support to import ground control points

in geographic coordinate system or projected coordinate system, and save ground control points and their
corresponding paired images point

12. Add more accuracy levels for dense image matching, including ultra-high precision, high precision, medium
precision and low precision

13. Add the option of whether to perform color unifying and color correction in the orthophoto mosaic module
14. Support editing stitching lines of multi-spectral data
15. Support changing of visualization color bar for DEM / DSM
16. Support adjusting the point size of a point cloud in 3D view
17. Add the EDL display mode in 3D view
18. Optimize the image information panel, in which the inclination angle can be displayed and the columns in a

table can be sorted
19. Optimize the workspace panel, in which images can be displayed in groups and registration number of each

group can be shown as well
20. Improve the visualization of the progress bar
21. Add tips for insufficient hard disk space
22. Support the size of bounding box can be adjusted, and selecting area of interest for data procession
23. Support defining customized coordinate systems
24. Add the Australis camera parameter model, and support converting with the existing internal parameter

model
25. Improve the visualization of welcome widget
26. Add new project wizard
27. Suppprt continue running from break of project



Fixed Bugs

1. Fix the problem that the software works improperly due to lack of administrator rights
2. Fix the problem of unresponsive workspace panel when selecting images by pressing “ctrl + A”
3. Fix the problem that CUDA option is forced to activate when reopening the setting dialog after restarting the

software
4. Other minor bug fixes

LiMapper2.0 update9

Highlights and Key Features

1. Add camera calibration window, which allows to set the initial internal camera parameters
2. Improve the visualization ground control points, which support to add function of predicting photo markers
3. Improve hillshade display effect for DEM / DSM
4. Improve the sparse point cloud filtering algorithm to noise points
5. Modify the default output resolution of Orthomosaic / TOrthomosaic to resolution of the original image
6. Support resetting POS information
7. Add close project function
8. Support writing the focal length information when the orthoscopic image is exported
9. Support switching the quality report language between English and Chinese

10. Support the size of bounding box can be reseted

Fixed Bugs

1. Fix the lack of data block in dense image matching;
2. Other minor bug fixes

LiMapper2.0 update6

Highlights and Key Features

1. Enhanced CUDA acceleration , increasing processing by 5~10 times.
2. Support for non-CUDA graphic cards.
3. Support for images without POS data. (Can only produce DSM. Does not generate DEM.)
4. Control DEM/DSM/Orthomosaic production area by adjusting bounding Box.
5. Support for concurrent instances.
6. Import Roll, Pitch, and Yaw data.
7. Export DEM/DSM/Orthomosaic, Stitching Lines, and individual Ortho Photo.
8. Auto UI language selection by system.
9. Display mouse point elevation in DSM view (right-click).

10. Option to disable Hillshade effect.
11. Improved speed and stability for Aerotriangulation.
12. Improved Sparse Cloud – Fast algorithm with reduced noses.
13. Enhanced Dense Cloud – Accurate algorithm.
14. Improved 3D visualization and user interaction.
15. Improved Stitching Lines editing.
16. Improved software UI.

Fixed Bugs

1. Fixed a bug that could cause crash when using Dense Cloud – Accurate option.



2. Fixed a bug that could cause coordinate system information loss when loading new images after removing all
images previously loaded in the project.

3. Other minor bug fixes.

LiMapper1.4 update5

Highlights and Key Features

1. Capable of processing very large number (>10,000) of high resolution images.
2. Efficient and maximized utilization of computation resources.
3. Streamlined and simplified workflow.
4. Improved internal algorithms.
5. Import and Export of POS file.
6. Export to Point Cloud.
7. Export DEM/DSM as .tif files.
8. Hillshade effect for DEM/DSM display.
9. Support for the use of external DEM data.

10. Dense Cloud/Tie Points options for building DEM/DSM – High Density for best result; Spare Density for fast
processing speed.

11. Options for different image blending modes – High for best results; Low for fast processing speed.
12. Display stitching lines.
13. Orthomosaic editing.

Fixed Bugs

1. Fixed a bug that read the EXIF exception
2. Fixed a bug that the exported bundler type is wrong
3. Fixed a bug that exist in the process of undistort photos
4. Other minor bug fixes.
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End User License Agreement
PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User License
Agreement ("EULA") is a contract between (a) you (either an individual or the entity you represent) and (b)
Greenvalley International Inc ("GVI") that governs your use of the software product (“Software”). This EULA
does not apply if there is a separate license agreement between you and GVI or its suppliers for the Software,
including a license agreement in online documentation. The term "Software" may include (i) associated media, (ii)
a user guide and other printed materials, and (iii) "online" or electronic documentation (collectively “User
Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO ALL
TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OR OTHERWISE
USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU DO NOT ACCEPT THIS
EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE SOFTWARE. IF YOU PURCHASED THE
SOFTWARE BUT DO NOT AGREE TO THIS EULA, PLEASE RETURN THE SOFTWARE TO YOUR PLACE OF
PURCHASE WITHIN FOURTEEN DAYS FOR A REFUND OF THE PURCHASE PRICE; IF THE SOFTWARE IS
INSTALLED ON OR MADE AVAILABLE WITH ANOTHER GVI PRODUCT, YOU MAY RETURN THE ENTIRE
UNUSED PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to GVI proprietary software (“GVI
Software”), software under licenses from third parties (“Third Party Software” and “Third Party License”). Any
Third-Party Software is licensed to you subject to the terms and conditions of the corresponding Third-Party
License. Generally, the Third-Party License is in a file such as “license.txt” or a “readme” file. You should
contact GVI support if you cannot find a Third-Party License.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and conditions of
this EULA:

a. Use. GVI grants you a license to Use one copy of the GVI Software. "Use" means installing, copying,
storing, loading, executing, displaying, or otherwise using the GVI Software. You may not modify the GVI
Software or disable any licensing or control feature of the GVI Software. If this Software is provided by GVI
for Use with an imaging or printing product (for example, if the Software is a printer driver, firmware, or add-
on), the GVI Software may only be used with such product (“GVI Product”). Additional restrictions on Use
may appear in the User Documentation. You may not separate component parts of the GVI Software for
Use. You do not have the right to distribute the GVI Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the GVI Software,
provided each copy contains all the original GVI Software's proprietary notices and is used only for back-up
purposes.

3. UPGRADES. To Use GVI Software provided by GVI as an upgrade, update, or supplement (collectively
“Upgrade”), you must first be licensed for the original GVI Software identified by GVI as eligible for the
Upgrade. To the extent the Upgrade supersedes the original GVI Software, you may no longer use such GVI
Software. This EULA applies to each Upgrade unless GVI provides other terms with the Upgrade. In case of
a conflict between this EULA and such other terms, the other terms will prevail.

4. TRANSFER. You may not rent, lease or lend the GVI Software or Use the GVI Software for commercial
timesharing or bureau use. You may not sublicense, assign or otherwise transfer the GVI Software except as
expressly provided in this EULA.



5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation are owned
by GVI or its suppliers and are protected by law, including applicable copyright, trade secret, patent, and
trademark laws. You will not remove any product identification, copyright notice, or proprietary restriction
from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or disassemble the
GVI Software, except and only to the extent that the right to do so is allowed under applicable law.

7. CONSENT TO USE OF DATA. GVI and its affiliates may collect and use technical information you provide in
relation to (i) your Use of the Software or the GVI Product, or (ii) the provision of support services related to
the Software or the GVI Product. All such information will be subject to GVI’s privacy policy. GVI will not use
such information in a form that personally identifies you except to the extent necessary to enhance your Use
or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability of GVI and
its suppliers under this EULA and your exclusive remedy under this EULA will be limited to the amount
actually paid by you for the Product. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN
NO EVENT WILL GVI OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR
CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS
INTERRUPTION, PERSONAL INJURY, OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF
OR INABILITY TO USE THE SOFTWARE, EVEN IF GVI OR ANY SUPPLIER HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF ITS ESSENTIAL
PURPOSE. Some states or other jurisdictions do not allow the exclusion or limitation of incidental or
consequential damages, so the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. Software was developed entirely at private expense. All Software is
commercial computer software within the meaning of the applicable acquisition regulations. Accordingly,
pursuant to US FAR 48 CFR 12.212 and DFAR 48 CFR 227.7202, use, duplication and disclosure of the
Software by or for the U.S. Government or a U.S. Government subcontractor is subject solely to the terms
and conditions set forth in this End User License Agreement, except for provisions which are contrary to
applicable mandatory federal laws.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i) applicable to
the export or import of the Software, or (ii) restricting the Use of the Software, including any restrictions on
nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. GVI and its suppliers reserve all rights not expressly granted to you in this
EULA.
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